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1. INTRODUCTION
Interaction is the most powerful companion to a web server, and is a complete solution 
for creating and managing dynamic and social websites that automatically adapt to the 
visitors. The application provides a sophisticated and ßexible framework for advanced 
services that substantially enhance the capabilities of your web server. 

Make Your Web Site a Social Place
Interaction makes your web site an exciting social place. It provides chat rooms and mes-
sage boards so visitors to your site can communicate with others using nothing more 
than a web browser. Any of your pages can include information about who and how 
many visitors currently are on a page or visiting your site. Such features provide aware-
ness about what others are doing and make your pages into meeting points. A very ßex-
ible membership feature allows you to restrict parts of your site for access by privileged 
members

Provide Exciting Dynamic Locations
Interaction puts a rich collection of entities at your disposal. Entities provide content to 
be embedded in your pages, similar to ÒServer-Side IncludesÓ but in a manner that 
adheres to the international standard for markup. Simple entities include the current 
time or the domain name of the visitor. Entities can easily be embedded in your pages 
using standard entity-references, with no need to use mock HTML tags, overloaded 
comment tags, or programming code as part of the documents. Any HTML page on your 
site can be provided through Interaction to beneÞt from the entities and other capabili-
ties.

Monitor Individual Visits
Interaction pioneered the technique of tracking visitors as they browse from page to 
page on the web. The application tracks visitors in the most reliable manner, without 
requiring the visitor to register nor to use a browser that supports cookies. Interaction 
uses this capability to provide many advanced features. For example, Interaction has 
windows that allow you to inspect current visitors to the site as well as recent visits.

Customize the Formatting
Interaction provides signiÞcant control over the formatting of your pages and services. 
This facilitates ease of customization and a consistent design. Interaction goes beyond 
editable headers/footers for customization by automatically adapting the presentation 
of the site based on formatting rules and your own content.

Interaction balances ease of use with power and ßexibility. It provides dialogs and does 
not require you to do any HTML markup, editing of cryptic Þles, scripting or program-
ming. Still capabilities to go Òunder the hoodÓ are readily available for those that want to 

customize the services or changes to the application. 
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Follow Major Standards
 Interaction is a light-weight SGML publishing system, consistently following the inter-
national standard for markup on which HTML is based. Interaction adheres to SGML 
and other open standards instead of require you to use bogus ÒcommandÓ tags, non-
standard coding, or home-made scripting languages. This optimizes the ability for reus-
ing content, which makes your site management more efÞcient and creative.

Extend the Functionality
Interaction is extremely extendable. The software is component-based and new features, 
tools and services can be added as optional components so you can customize Interac-
tion for your own needs.

No scripting is required, but for those with some scripting experience, Interaction has a 
built-in deveopment environment with full access to the internal features of the soft-
ware. If thatÕs not enough, new features can be implemented using the ANSI-standard 
object-oriented dynamic programming language Common LISP with more than 2000 
well-deÞned functions, in addition to AppleScript and other OSA scripting languages. 
Scripts can be embedded directly in markup for rapid prototyping, or be used to make 
new tools, entities and other features.

Welcome to the Interaction Community
Interaction has been developed with input from hundreds of site maintainers as to how 
it could solve their needs. Your feedback is also very welcome. To keep updated concern-
ing the progress of Interaction, subscribe to the www-interaction mailing list by sending 
a request to:

 www-interaction-request@in-progress.com 

Also, your are encouraged to visit the Interaction website at:

http://interaction.in-progress.com

Comments and suggestions are always highly appreciated, as the application and its 
extensions are under continuous development.

Acknowledgments
Interaction has beneÞted from work by some of the best programmers in the world. I 
would like to direct my appreciation to Digitool (in particular Stephen L. Hain, Hazem 
Sayed, Bill St. Clair and Alice Hartley) and Apple for respectively developing and spon-
soring Macintosh Common LISP, the powerful development environment in which 
Interaction is implemented. Bill St. Clair and Apple Advanced Technology Group also 
get credit for WOOD, the object database built into Interaction. Ray Pelletier and John 
Mallery are among many others whose code is integrated in the application. 

Interaction would not be what it is today without a year of feedback and suggestions 
from hundreds of webmasters for the beta versions of the software. Thank you all!
Terje Norderhaug <terje@in-progress.com>

http://interaction.in-progress.com/


                                 
GETTING STARTED   9

2. GETTING STARTED
Interaction is easy to install and conÞgure, and you should expect to get the services up 
running within minutes. This chapter will provide an overview of the Þles and folders in 
the distribution of Interaction and how to conÞgure various web servers for the applica-
tion. The README Þle that come with the distribution provide a quick start to set up 
Interaction with your web server. Solutions to common problems are found in the FAQ 
at:

http://interaction.in-progress.com/faq

Installation
Place the Interaction folder anywhere on your harddrive, but preferably not in the same 
folder as the server software for security reasons. The Interaction application is distrib-
uted with the following Þles and folders:

README: Provides an introduction, hints, and 
license information. Read this Þrst!

Documentation: Contains documentation Þles for the 
software.

Documents: Contains Þles and folders for the Interac-
tion section of your web-site. 

Data: Contains additional information for your web 
site, including entities and members. 

Components: The Þles in this folder extend Interaction with new features and services.

Tools: Any Þle in this folder will be listed on the Tools menu of Interaction and can be 
executed by selecting the corresponding item from the menu.

Log: Contains one or more Þles with errors and other useful information recorded as vis-
itors browse your pages.

Goodies: Contains optional components and tools for customizing Interaction.

ConÞguring the Web Server
Interaction works with a web server in providing documents and services to your visi-
tors. This section describes how to conÞgure various web servers for Interaction. The 
documentation for your web server should provide additonal details on how to conÞg-
ure the server with applications such as Interaction.

In general, there are three ways to integrate Interaction with a server. These vary accord-
ing to how the server determine which application a request should be passed on to:

¥ As a Preprocessor: The web server will pass all requests directly to a preprocessor. Any 
location served by Interaction will merge seamlessly with the rest of your site. In most 

cases, this is the preferable way to conÞgure the server for Interaction. Adding Interac-
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tion as a preprocessor will not affect the documents of your site that are not served by 
Interaction.

¥ As a CGI (or ACGI): Here the server will depend on the URL to determine when a 
request should be passed on to Interaction. Any request of which path includes an 
alias to the Interaction application will forward the request. For example, given that an 
alias to the Interaction application is located in the folder of the server and labeled 
ÒInteractionÓ, the services can be accessed with an URL addressing this alias, followed 
by a Ó$/Ó and the name of the location, e.g.:

    http://www.myserver.com/interaction$/chat

¥ With SufÞx-map(s): In this mode, the server will depend on the sufÞx in the request to 
determine that Interaction should get the request. A sufÞx is the part of a Þle/URL that 
begins with a period, e.g. Ò.htmlÓ. A sufÞx map  should map the empty sufÞx to Inter-
action so that all requests for URLs with no sufÞx are forwarded to Interaction. You can 
add maps for additional sufÞxes (such as Ò.htmlÓ)  so all requests for documents with 
these sufÞxes are passed to Interaction.  Note that not all servers support empty suf-
Þxes in the sufÞx map.

Here is how various servers are conÞgured for Interaction:

WebStar
WebStar <http://www.starnine.com/webstar> is best conÞgured with Interaction as a 
preprocessor:

1. Make an alias to Interaction by selecting the application and choose ÒMake AliasÓ 
from the File menu of Finder. Move this alias to the same folder as the WebStar appli-
cation, and rename it to ÒInteractionÓ.

2. Open the WebStar Admin application, and select the WebStar server. Choose 
ÒActionsÓ in the ConÞgure menu of WebStar. In this dialog, type in Ò:InteractionÓ for 
the Application. Give the new action the Action Name ÒINTERACTIONÓ. Click the 
Add button to create a new action, then Update to make the new action available.

3. From the ConÞgure menu of WebStar, go to the Misc. Settings dialog. Type in ÒInter-
actionÓ in the PreProcess Þeld, then click ÒUpdateÓ.

4. The Interaction services can now be accessed using URLs such as 
Òhttp://www.yoursite.com/forumÓ.

As a preprocessor, any document on your site can be served through Interaction to bene-
Þt from the dynamic entities, access restrictions, and other features of Interaction. Details 
about how to import existing Þles is found in the section called ÒAdding Existing HTML 
FilesÓ on page 22.

The HomePage of the site will automatically be served by Interaction, so if you already 
have a pre-made homepage you are advised to import it into Interaction either by using 
Import from the File menu, or by explicitly move the Þle to the Documents folder, 
rename it to Òindex.htmlÓ, and open the Homepage from the File menu in Interaction to 

make the application aware of the changes. 

http://www.starnine.com/webstar
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If you for any reason decide that you donÕt want the homepage to be served by Interac-
tion, set the access restriction of the ÒindexÓ location to ÒNot AccessibleÓ (see ÒAccess 
RestrictionsÓ on page 45). This will leave to the server to provide a homepage. 

Note that WebStar (at least versions 1.3 and 2.0) has a ßaw that causes it to write a warn-
ing about Þle not found when a preprocessor such as Interaction create a page without a 
corresponding Þle in the folder of WebStar. This is ignorable and will hopefully be elimi-
nated with future versions of WebStar.

WebStar can also be conÞgured using Interaction as an ACGI:

1.  Make an alias to Interaction by selecting the application and choose ÒMake AliasÓ 
from the File menu of Finder. Move this alias to the same folder as the WebStar appli-
cation, and rename it to ÒInteractionÓ.

2. Start Interaction as well as WebStar. The Interaction services can now be accessed 
using URLs such as Òhttp://www.yoursite.com/interaction$/forumÓ.

It is usually preferable to conÞgure the server with Interaction as a preprocessor, as this 
allow you to serve any document through Interaction and eliminates the Ò/interaction$Ó 
in the URL.

 

Web Server 4D

 

WS4D <http://www.mdg.com> can be conÞgured with Interaction as a PreProcessor:

1. Open the ÒWeb Server SetupÓ dialog from the File menu of WS4D.

2. Click the PreProcess button in the left bottom corner of the Setup form of the dialog.

3. Select the Interaction application from the Þle selector.

With Interaction as a preprocessor, 

 

all

 

 requests to your site will be routed through Inter-
action. As an alternative you can conÞgure the sufÞx-maps so that only requests with an 
empty sufÞx is forwarded to Interaction:

1. Go to the dialog named ÒWeb Server Setup.Ó 

2. Select the ÒSufÞx MapsÓ form.

3. Click ÒAdd.Ó 

4. In the ÒChoices for ActionsÓ, select ACTION.

5. Leave the cells for sufÞx, APL, and MIME type empty (this will give the defaults). 

6. Type in the word ÒInteractionÓ in the rightmost Action cell, and hit the Enter button 

 

(not return) with the cursor afterwards. Select the Interaction application in the 
resulting dialog.

Hint:  If you cannot access the Interaction services, make sure to remove any other sufÞx maps that has a 
blank or star in the sufÞx cell.

http://www.mdg.com/ipmanual.html
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Quid Pro Quo
Quid Pro Quo <http://www.slaphappy.com> is best conÞgured with Interaction as a 
PreProcessor:

1. Make an alias to Interaction by selecting the application and choose ÒMake AliasÓ 
from the File menu of Finder. Move this alias to the same folder as the Quid Pro Quo 
application, and rename it to ÒInteractionÓ

2. From the Control menu of Quid Pro Quo, select the ConÞgure Server dialog.

3. Select the Actions category from the lefthand table. Click the ÒNewÓ button to create 
a new action. Type in ÒInteractionÓ for action and ÒInteractionÓ for the path.

4. Select the Processors category from the lefthand table. Click the New button to add a 
preprocessor. Type in ÒInteractionÓ as the path to the alias to the Interaction applica-
tion.

5. After starting the Interaction application, the Interaction services are accessed from 
the URL <http://www.yoursite.com/index>.

Quid Pro Quo can optionally be conÞgured with Interaction as an action using a ÒsufÞx-
mapÓ with an empty sufÞx:

1. Make an alias to Interaction by selecting the application and choose ÒMake AliasÓ 
from the File menu of Finder. Move this alias to the same folder as the Quad Pro Quo 
application, and rename it to ÒInteractionÓ

2. From the Control menu of Quad Pro Quo, select the ConÞgure Server dialog.

3. Select the Actions category from the lefthand table. Click the ÒNewÓ button to create 
a new action. Type in ÒInteractionÓ for action and ÒInteractionÓ for the path.

4. Select the MIME Mappings category from the ConÞgure server dialog. Create a new 
map by clicking the new button. Leave the sufÞx Þeld empty, and type in text/html 
in the Þeld for MIME type. From the pop-up menu, set the Action to Interaction.

Microsoft Personal Web Server
MPWS can be used as a web server for Interaction. Contact the Interaction FAQ for 
updated information:

http://interaction.in-progress.com/faq

MacHTTP
MacHHTP <http://www.starnine.com/machttp> requires Interaction as a CGI or 
ACGI: 

1. Make an alias to the Interaction application.

2. Move this alias to the same folder as MacHTTP.

3. Change the name to ÒInteractionÓ.

4. Start Interaction and the server. The services can be accessed by using your domain 
name in place of www.yourserver.com in this URL:

http://www.slaphappy.com/
http://www.starnine.com/machttp
http://interaction.in-progress.com/faq
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    http://www.yourserver.com/interaction

Note that as MacHTTP doesnÕt support sufÞx mapping, the URL for most pages will 
contain the name of the alias ending with "$/" such as 

http://www.yourserver.com/interaction$/chat/room1

Hint:  A trick to simplify the URL is to set the default page item in the conÞg Þle of MacHTTP to be ÒInter-
actionÓ instead of Òdefault.htmlÓ. This will eliminate the word ÒInteractionÓ in the URL, but the dollar 
sign is still required except for the default homepage.

NetPresenz
NetPresenz <http://www.share.com/stairways/netpresenz/netpresenz.html> should 
be conÞgured with Interaction as a CGI:

1. Move the Interaction application to the to the top of the folder speciÞed by NetPre-
senz to act as the WWW root. Move the Data, Documents, Plug-ins and Tools folder 
of Interaction to this folder as well.

2. Rename the Interaction application to Òinteraction.acgiÓ.

3. Start NetPresenz and Interaction.

4. You should now be able to access the Interaction documents using an URL such as.

http://www.yourserver.com/interaction.acgi

If security is an issue, move the Data folder of Interaction outside the NetPresenz folder. 
Make an alias to the folder, move it back to the same folder as Interaction, and rename it 
to ÒDataÓ. This will ensure that the passwords and other information of Interaction are 
not available on the Web.

NetWingz
NetWingz <http://netwingz.com> can be conÞgured to handle Interaction as an ACGI. 
Contact the manufacturer for information conÞguring NetWingz.

InterServer Publisher
No instructions are yet available for this server. Contact the manufacturer for informa-
tion about how it should be conÞgured with Interaction.

Upgrading From Previous Versions
New versions of Interaction are available from:

http://interaction.in-progress.com

Be aware of the following issues when upgrading:

1. It is a good idea to make a backup of the Documents and Data folder before upgrad-
ing just in case.

2. Only the Documents and the Data folders should be copied from an old version to a 
new version. These folders contain your site information and are thus required.

http://www.share.com/stairways/netpresenz/netpresenz.html
http://netwingz.com/
http://interaction.in-progress.com
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3. Remember to move your personalized license from the components folder of the old 
version to the folder of the new.

4. The contents of the Tools and the Components folders may conßict with the new ver-
sion. Make sure that you only use the Tools and Components for the most recent ver-
sion of Interaction to avoid malfunctions.

Memory Requirements
The memory required to run Interaction will vary, depending on the size of your website 
as well as on the number of concurrent visitors. Interaction is relatively memory inten-
sive1, and you are advised to avoid using virtual memory as this will slow down the 
application dramatically.

The standard version of Interaction will run in a minimal partition of 3.5Mb and be com-
fortable in a 4.5Mb partition. The PowerPC native version will run in a partition of 
5.5Mb and be comfortable with 7.5Mb allocated to the application.

The ÒAbout InteractionÓ dialog displays how much of the allocated memory is currently 
not used by the application. This can be used to optimize the memory allocation. How-
ever, keep in mind that Interaction requires some available memory to process a request 
and may get into trouble if the memory allocation is too low. In general, it is a good idea 
to leave Interaction with plenty of allocated memory.

Important: In starting up the PowerPC native version of Interaction, the Macintosh OS 
load the shared libraries that come with the distribution. These shared libraries require 
approximately 3 megabytes of free space, and this is not included in the memory parti-
tion of the application. Thus you should not set InteractionÕs partition size to take up all 
the remaining memory on your Macintosh, but instead leave at least 3 megabytes of free 
memory. If there is not enough memory for the libraries, Interaction will show a dialog 
stating that the libraries cannot be loaded.
1. With todayÕs memory prices, the memory required cost less than $50!
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3. A TOUR OF INTERACTION
This chapter gives a quick tour of some of the services and features of Interaction.The 
following chapters provide more details about the various features and services:

¥ Managing a Dynamic Site (Chapter 4)

¥ Entities (Chapter 5)

¥ Chat Rooms (Chapter 6).

¥ Forums (Chapter 7)

¥ Membership and Restrictions (Chapter 8)

Subsequent chapters cover technical issues such as how to extend and modify the appli-
cation, as well as hints for troubleshooting.

Browsing the Locations
Interaction is pre-conÞgured with a ÓhomepageÓ, a forum, and a chat room, all of which 
can be accessed immediately after installing Interaction.The following is an example of a 
forum. Notice that the datestamps adapt depending on the current date and year! Also, 
the footer is deÞned to include various information about a visitor:

Accessing the Homepage
The ÒhomepageÓ of the site is accessed with the URL <http://www.yoursite.com/

index>  where www.yoursite.com is substituted with your own domain name. The 
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default homepage includes a linked list of the services currently available. If you use 
MacHTTP or NetPresenz (or havenÕt conÞgured the server with Interaction in its sufÞx-
map as described in "ConÞguring the Web Server" on page 9) you will have to insert an /
Óinteraction$ Ó after your domain- name in the URLs.

Checking Out Forum and Chat
The homepage may contain links to services and documents provided by Interaction. It 
is a good idea to become familiar with the services from a visitors perspective by brows-
ing the examples, posting messages in the forum and making some statements in the 
chat room.

The File Menu
The File menu contains general means to access the con-
tent of your site.

Creating Locations
The New Location item of the File menu provides a quick 
way to create new locations for your site. It gives a dialog 
to type in the locator of a new or existing document, and 
opens this in an editor.

Import is used to make existing documents become loca-
tions served by Interaction. It gives you a Þle selector to 
choose the Þle to import. 

Editing Files
Interaction has an advanced built-in text editor1 suited for 
direct editing of markup. The New Text File and Open File 
items of the File menu provide direct access to the various 
Þles for advanced webmasters that want to do changes 
directly on low level.

Exporting the Site
The Export item is used to export a snapshot of the site. 
Selecting this gives a dialog to choose a result folder. Each 
location of the site will be exported to this folder. 

Entities
Opening this dialog provides a self-documented list of available entities. Entities are 
used to embed dynamic elements in your pages,2 and make your site more ßexible and 
efÞcient to maintain. An entity is a value that can be embedded in your documents by 
using a corresponding entity reference. Entities serve a similar purpose as ÒServer-Side 
IncludesÓ as a reference in the document is substituted for a value at serving time. 

1. The editor of Interaction is a variation of the popular text-editor ÒEMACSÓ with a large number 
of short-cuts for efÞcient editing.

2. See page 25 for more details about making dynamic documents.
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The Homepage
As the homepage plays such a cen-
tral role to a site, Interaction makes 
it easily accessible. Choosing the 
Homepage item of the File menu 
gives you a dialog where you can 
type in a title and introduction for 
the homepage. If you need more 
extensive control of the HTML for-
matting of the page, you can use the 
ÒEdit HTMLÓ button to access the 
markup. 

Managing Locations
The Homepage and the services are not the only content provided by Interaction. Inter-
action is also a powerful general site maintenance tool. The Locations dialog lists all doc-
uments provided by Interaction, with updated information about their hits and how 
many visitors currently are in each location. This dialog is also used to specify the access 
restriction of each location.

The chapter ÒManaging a Dynamic SiteÓ on page 20 gives more details about how to use 
Interaction to manage the documents of your site.

Services

Each item on the Services menu provides a dialog to edit a spe-
ciÞc service. Subsequent chapters give in-depth information 
about how to customize the services: 

¥ Forums: page 39

¥ Chat Rooms: page 32

New services are distributed as components to Interaction. Each will add an item to the 
Services menu. The Shop service is an example of such an optional service, and this is 
available from:

http://interaction.in-progress.com/components

http://interaction.in-progress.com/components
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Tools
The Tools menu provides an extendable list of features. 
A tool typically provides a dialog that affects some inter-
nal functionality of Interaction or changes the docu-
ments or services.

The items on the Tools menu correspond with Þles in the 
Tools folder. You can tailor the menu by removing or 
adding Þles in the Tools folder, or by using the Edit Tools 
item of the menu. 

It is possible to edit some of the existing tools or extend 
Interaction with your own scripted tools (see the chapter 
ÒExtending InteractionÓ on page 46 for details).

Monitoring Activities
The Current Visitors dialog displays a list of all visitors 
currently visiting your site. Interaction has sophisti-
cated visitor tracking that allows the software to follow 
the visitors as they move from page to page. You can 
inspect details about each of the visitors by double-
clicking on any of the items in the list of current visi-
tors, which will show a dialog with detailed informa-
tion about each visitor and their activities at your site:
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Membership and Access Restrictions
Interaction has page-level access restriction to give a high extent of control of who can 
access various parts of the site. For example, document access can be limited to regis-
tered Members, or to those in a particular group. Each visitor has his own username and 
password that determines their access privileges, saving them from the hassle of main-
taining multiple passwords.

The Restriction pop-up menu on the Locations dialog is used to assign a restriction to a 
document. The Members dialog on the Windows menu contains the members of your 
site as well as the groups to which they belong. Further documentation regarding mem-
bership and access restrictions are found in the chapter ÒMembership and RestrictionsÓ 
on page 44.

Access restrictions can also contain conditions for making a document secret. A secret 
document will not be listed in any directory of documents. Interaction can thus adapt 
your site to the privileges of individual visitors.
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4. MANAGING A DYNAMIC SITE
Interaction facilitates advanced site maintenance with a dialog that gives you a full over-
view.   Locations can be created and edited within Interaction, and you can also add pre-
viously created HTML Þles to the Documents folder. Interaction turns your static pages 
into exciting dynamic locations that change over time and adapt to the individual visitor. 
The application serves all locations from a database, yet still offers the power of  being 
able to inspect and change individual Þles. 

Locations
A location is an independent part of your site, appearing as a speciÞc page to the visitor. 
Each location is addressed with its own unique URL. 

The Locations Dialog
The Locations dialog of the File menu provides an overview of all locations provided by 
Interaction:

The right side of the dialog provides details about each location. The locator Þeld show 
the Locator, which is the part of the URL (Uniform Resource Locator) that follows after 
the domain name of the site. Next is the title of the location, so you donÕt have to open 
the document or guess from the locator which document represent a location. The Type 
Þeld display the type of location. 

Hits and Occupancy
The hitcount shows how many times a location has been requested. The hits are counted 
in real time, so you donÕt have to  analyze the log Þles to Þnd how many times a speciÞc 
location has been visited. This number can be embedded in any document using the 
entity reference &hits; (see "Entity References" on page 26 for further details). Click on 
the number to modify or reset the hitcount.
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Occupancy is the number of visitors currently in a location. As Interaction track visitors 
as they move from location to location, each visitor will only be counted one place. The 
occupancy counter can be embedded in a document using the entity reference &occu-
pancy; (see "Entity References" on page 26 for more about this).

Access Restrictions
Interaction allows you to control who can access parts of the site. The pop-up menu 
labeled ÒAccessÓ in the restriction area of the dialog determines the access restriction of a 
particular location. If this is set to ÒPublicÓ, everybody can access the location. An access 
restriction for ÒMembersÓ limits the access to those that are registered with a username 
and password. There are also other access restrictions. For further information see the 
chapter "Membership and Restrictions" on page 44.

A powerful capability of Interaction is that it is able to adapt the presentation of the site 
depending on the access privileges of a visitor. The pop-up menu labeled ÒSecretÓ deter-
mines whether the location will be linked to from various automatically generated 
indexes provided by Interaction. For example, the entity ÒdocumentsÓ provides a linked 
list of all documents of the site1, but will not list items found to be secret for the speciÞc 
visitor.

Creating New Locations
New locations can be created from the Loca-
tion dialog. Clicking the New button gives 
you a dialog to select the document type 
and type in a locator for the new location. 
New locations can also be created by choos-
ing the ÒNew LocationÓ item of the File 
menu.

Documents
The Documents folder of Interaction contains documents that provide the content for  
the various locations served by Interaction. Interaction goes beyond the paradigm that a 
web server provides Þles. Instead, each location is represented by one or more Þles in the 
documents folder. However, Interaction facilitates migration from the old way of setting 
up a website. The Þles in the Documents folder are organized so that the name of the 
Þles and the sub-folders correspond to the URL.

One Location - Many Files
The Web standards emphasize that there doesnÕt have to be any one-to-one relationship 
between URLs and Þles on the web server. Despite this, the basic operation of most web 
servers is to serve a Þle addressed with a URL. Interaction goes beyond this paradigm to 
draw advantage from the more ßexible model suggested by the standards. Although the 
Þles in the Documents folder of Interaction to a high extent concur with the URLs they 
are associated with, many of the documents served by Interaction use information from 
several Þles and other sources to create the resulting page for a request.
1. This entity can be embedded in any document using the entity reference &documents;
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When presenting the location, Interaction will ignore the sufÞx of the Þle or Þles repre-
senting it. Interaction allows a location to be represented by more than one Þle. These 
Þles will have the same name but different extensions. For example, Interaction may 
keep the core information of a document in a Þle called ÒtestÓ and the HTML version in a 
Þle called Òtest.htmlÓ. This allows you to use different editors to inspect the various 
aspects of a document.

The description of a document is usually kept in a Þle in the Documents folder. 
The Þle or Þles representing a document will be located in a sub-folder that cor-
responds to the path-name of the location used in the URL, as is commonplace 
with most web servers. For example, if the path-name of the location is Òpath/
nameÓ the Þle will have the name ÒnameÓ and be stored in a folder named ÒpathÓ. 

Editing the Documents
Many of the services on Interaction can be customized with an associated HTML page to 
customize the HTML formatting of the services. These pages go beyond templates and 
let you design the format of the associated document or documents using HTML. If such 
a Þle is available for a document, it can usually be accessed by clicking the ÒEdit HTMLÓ 
button on the respective dialog. This gives you a default HTML page in a text-editor, and 
you can edit this as you please. If you want to revert to the default HTML, delete all text 
in the page and verify that you want to revert to the default when saving.

The document Þles can also be edited directly in the text editor of Interaction if you are 
familiar with markup. All markup follows the SGML standard on which HTML is based, 
with no mock tags or mix between markup and programming code. Such respect for the 
philosophy behind the Web technology and the standards result in reusable content that 
can be manipulated with standard tools.

Adding Existing HTML Files
The Import Location item of the File menu provides a convenient way to add existing 
HTML Þles as source for locations. It permits Interaction to update its database and 
internal data as required to serve the latest version of the content.

However, you may want to import larger numbers of HTML Þles. Interaction allows you 
to move these Þles directly to the Documents folder as long as you take the necessary 
steps to keep InteractionÕs database consistent. Documents previously served directly by 
the web server can be advanced to be provided through Interaction:

1. Quit Interaction. Trash the Þle called ÒCache DatabaseÓ. This ensures that Interaction 
recreates the cache database correctly when starting up. 
2. Move the HTML Þles from the folder of the web server to the Documents folder of 
Interaction, eventually creating new corresponding sub-folders as required.

3. Restart Interaction to make Interaction aware of the Þle and able to cache the HTML 
Þles to the database. 



MANAGING A DYNAMIC SITE   23

The Object Database
Interaction serves the locations of your site from an object database for speed and ßexi-
bility in processing. At the same time, the application maintains the content as Þles in the 
Documents folder to allow them to be modiÞed by standard tools. Interaction provides 
you with the advantages of both ways of serving the site, and eliminates the disadvan-
tages of either.

When Interaction is started for the Þrst time, it loads the Þles in the Doc-
uments folder into a sophisticated object database1. The Þles are refor-
matted and indexed to allow advanced features and to speed up the 
processing. Interaction will keep all or the most often requested parts of 
the database in the memory of the computer to save the delay of Þle 
accesses. 

The database acts as a cache where all content is kept in the original format in the Docu-
ments folder. Thus, you donÕt need to make backup of the cache database. It will be auto-
matically rebuilt if it is removed. You may Þnd it beneÞcial to quit Interaction and clear 
the Þle from time to time particularly whenever you make larger changes in the Docu-
ments folder without going through Interaction.

Central Concepts
A number of terms are used in this documentation and in the interface of Interaction to 
denote the various stages of the information:

¥ The Location is the Òvirtual placeÓ or comprehensive unit of content that the visitor 
perceives for a page. Your site consists of a number of locations, each having their own 
unique URL (Uniform Resource Locator). The visitor can direct the browser to the var-
ious locations of your site, for example by using ÒOpen LocationÓ from the menu in 
Netscape or by following a link.

¥ The Page is what the visitor views in their browser. It is a presentation of a location for 
a particular visitor at a speciÞc time. The same location can be represented with differ-
ent pages. 

¥ A Resource is the general object representing a location in Interaction. Your site consist 
of various resources.

¥ A Document is a type of resource that has the ÒintelligenceÓ to bring together various 
information sources and creates a presentation depending on the context of the 
request. Each document is of a speciÞc Document Type where documents of the same 
type share characteristics. A document is usually represented as a Þle in SGML format 
and eventually one or more auxiliary Þles.

¥  Files physically represents the Document as it is stored on your computer. 
1. Thanks to Apple Advanced Technology Group for sponsoring the WOOD object database.
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Summary
¥ The Locations dialog of the File menu contains an overview of the locations provided 

by Interaction.

¥ New locations are created from the Locations dialog or by selecting the New Location 
item from the File menu.

¥ The Locations dialog provides some general information about each location, such as 
hitcount and the current occupancy.

¥ You can assign an access restriction to each location, which determines who can access 
it.

¥ Interaction serves the locations based on content in a database, so new documents has 
to be added through Interaction or will require that the application is restarted without 
the Cache Database.
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5. ENTITIES
Entities are central for intermediate to advanced use of Interaction. In particular, entities 
and entity references are extensively used in customizing the structure and formatting of 
locations. Use of entities require familiarity with markup. Examples of entities include 
time, default headers and footers, lists of available services or documents on your site, 
and many more.

An entity is a collection of information that can be referenced as a unit. Entities are used 
to provide dynamic elements of documents and to make site management more efÞcient 
by minimizing duplicated content. Each entity generates an entity value, which may 
vary depending on the current context. The entity value is embedded in a document in 
place of an entity reference.

For example, the entity reference &interaction;  will be replaced with its entity value: 
a link to the Interaction site. Placing this entity reference in any document will embed the 
value in place of the entity reference before the page is presented to the visitor. 

The Entities Dialog
The Entities dialog of the File menu pro-
vides an overview of the general entities 
of the site. These entities can be used in all 
documents of the site. Each entity has a 
description and a sample value displayed 
in the dialog. It is a good idea to explore 
this dialog to get an overview of the enti-
ties and their use. Activate balloon-help 
for some hints about using the entities.

Interaction provides a wide selection of 
general entities that can be embedded in 
any document. Note that some documents have their own speciÞc entities which are not 
listed in the overview of general entities. Here is a sample of the entities: 

Entity Description

browser The name of the browser of the particular visitor

date The current date

documents A linked list of the general documents of the site (except the one 
that embeds the entity and those set to be secret for the visitor)

domain The domain name of the visitor

hits The number of times the document has been requested

index A linked list of the general documents in the same folder as the 
current one, except the index document
Table 1: A sample of the general entities provided by Interaction
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The entities listed above are just a few of the many entities provided by Interaction. The 
Entities dialog of the File menu list many others.

Entity References
The value of an entity is embedded in a document in the place of a corresponding entity 
reference. Entity references are not commands or instructions, but a reference to replace-
ment content. The same entity can be placed in several documents.

How to Refer to an Entity
An entity reference is a label separated from the rest of the content. Entity references 

modiÞcation-date The date for when the current document was last modiÞed

occupancy How many concurrently are in the same location

referrer The URL of the previous location

services A linked list of the available services

site-occupancy How many are currently visiting the site

staytime How many seconds the visitor has been on the site

time The current time in hours, minutes and seconds

track-length How many documents the visitor has browsed on the site

visitors A list of the nicknames of those currently in a location

visitor-origination The URL of the location the visitor came from before visiting your 
site.

Entity Description

Table 1: A sample of the general entities provided by Interaction
start with an ampersand followed by the name of the entity ending with a semicolon. For 
example, to embed the value of the entity ÒhitsÓ on your pages simply add the entity ref-
erence &hits; where you want to have the hit-counter. 

Why do Entity References Start With an Ampersand?
Entity references are part of the International standard for markup (SGML) thus already 
a concept in HTML. The ampersand is the standard way to separate an entity reference 
from regular content of a document. The syntax for an entity reference is the same as 
used in HTML pages to embed special characters such as &lt; for the less than sign. 
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Creating a New Entity
New entities are created from the Entities 
dialog of the File menu:

1. Click the New button to get a dialog for 
creating the entity

2. Select an entity type from the pop-up 
menu, or use the default Text entity.

3. Type in a name for the entity. You can only use characters, digits, periods, and 
hyphens in entity names1.

4. Click Create and the new entity will be added to the available entities. 

5. Usually you will automatically get a dialog to deÞne the new entity. This dialog is 
dependent on the entity type.

6. The new entity can be embedded in your documents using an entity reference. An 
entity reference starts with an ampersand, followed by the name of the entity, ending 
with a semicolon.

Entity Types
Each entity is of a speciÞc type which determines the characteristics of the entity. Interac-
tion provides Þve basic entity types: text, alias, color, argument value and Þle.

Text Entities
Entities of the Text type provide replacement text. The value of the entity is the text and 
markup as typed in the editor for the entity. Text entities can even include entity refer-
ences, so you can create new entities that combine other entities and markup.

A common use of text entities is to ease site management by maintaining repeatedly 
used content as entities. In this manner, changes can be made in one place rather than 
requiring a search/replace of all documents of the site.

Color Entities
Color entities represent colors. Each color is 
deÞned in a dialog, saving you from having to 
mess with Þguring out the cryptic color codes 
required by the various browsers. This makes it 
easy to experiment with the colors for your site. 
The color selections is kept in one place so you 
can change these without having to edit all doc-
uments.
1. This is according to the SGML standard.
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Interaction has several predeÞned color entities that correspond with the Netscape 
extensions to use attributes of the body element to change colors:

For example, say you want to use a background color for most of your site. Instead of 
adding the color code in the BODY attributes, you can add the entity reference for the 
color feature as an attribute value:

<BODY BGCOLOR=”&bgcolor;”>

Place the entity reference for a color anywhere in your documents where you would use 
the code for a color.

Alias Entities
An alias entity is an alternative label for another entity, similar to an alias as used in the 
MacOS. This allows use of more than one name for an entity.

Argument Entities
Argument entities provide the values of a form 
submission. Use this entity for example to pro-
vide feedback when a visitor submits a form. 
Each argument entity provide the value of a spe-
ciÞc named Þeld in the form. The name of the 
Þeld is speciÞed in the dialog for the entity, and is by default the same as the entity name. 
here is one way of using Argument Entities:

1. Create a form with one or more Þelds to submit to a location. 

2. Using the new button of the Entities dialog, create entity references that correspond 
to the names of the Þelds in the form.

3. Place entity references for the argument entities in the document of the location that 
the form is submitted to. 

For example, say a document contains the following form to collect the phone-number of 
a visitor. This will submit the Þeld with the phone-number to the location named Òfeed-
backÓ:

<FORM ACTION=”/feedback”>
Phone Number: <INPUT NAME=”phone-number” SIZE=40>

Entity Description

bgcolor The color of the background

text-color The color of the text

link-color The color of a link

active-link-color The color of a not yet followed link

Table 2:  PredeÞned color entities
</FORM>
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In the document of the location ÒfeedbackÓ, place the entity reference &phone-number;  
wherever you want to embed the value of the submitted Þeld. Note that any location 
provided by Interaction can provide feedback for a submitted form.

The submitted value sticks with the visitor as long as he is on your site. Thus, in any sub-
sequent document the submitted phone-number can be embedded using the entity-ref-
erence &phone-number;  or whatever you have decided to label the argument entity.

File Entities
The File entity type make Þles into entities, so they can be referenced using an entity ref-
erence and embedded as part of a document. The Þle is selected by using the familiar Þle 
selector of your Mac so you donÕt have to Þgure out the directory path yourself. 

Wherever the entity is referenced in your documents, Interaction will embed the content 
from the Þle in place of the entity reference at the time the document is served. Entity ref-
erences in the Þle will be resolved and the content of the Þle will be processed just as if it 
was placed directly in the document. 

The File entity contains a reference or alias to the Þle. If you change the content of the Þle 
the changes will be reßected in the pages seen by the visitors. You can integrate Þles into 
your website without being limited to locating these in the folders of Interaction or your 
web server.

Additional Entity Types
Interaction can be extended with new entity types in the form of plug-in components. 
You only have to install the entity types that you Þnd useful, allowing you to customize 
the site maintenance to Þt your needs. New entity types can be downloaded from:

http://interaction.in-progress.com/components/entity-types

These are some of the optional entity types that can be downloaded:

¥ Random entities randomly pick one of several items as its value. Random entities can 
be used to make your site more exiting by making parts of the pages change from 
access to access.

¥ Banner-ads entities makes it easy to add random banner ads to a site. The various 
banners for an ad is pasted into a dialog, with the link where the visitor will go as a 
result of clicking the banner. These entities even count how many times each banner 
has been clicked to make it easy to manage the collection of a revenue from the ban-
ners.

¥ Counter entities increments a counter each time a visitor submits a form Þeld that 
matches a speciÞc pattern. This entity type can for example be used to create voting 
features.

¥ Function entities executes your script to create a value. The script can be written in 
LISP, AppleScript, HyperTalk, or other OSA scripting languages. It provides an alter-
native to conventional CGIÕs. Using this entity type saves you from the mess of mixing 

markup with script code.

http://interaction.in-progress.com/components/entity-types
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Referencing Entities with URLs
An advanced feature of Interaction is that each entity can be referenced with a URL. This 
is useful for site administration to inspect the value of an entity. Also, it can be used to 
facilitate management of Frames. 

The URL of an Entity
The syntax of the entity URLs is that the name of the entity is passed in the search argu-
ments following the URL of a location. For example, the following URL will return the a 
number for how many currently are on the homepage:

http://www.yoursite.com/index?entity=occupancy

The reference consists Þrst of the URL for a particular location, then a question-mark, 
then Òentity=Ó followed by the name of the entity. This is equivalent to submitting a form 
Þeld with name ÒentityÓ:

<FORM ACTION=”/index”>
<INPUT NAME=”entity” VALUE=”occupancy” SIZE=40>
</FORM>

The entity will be formatted as it would have been embedded in the location. Any entity 
references in the entity will be expanded as if the entity was embedded in the location.

Using an Entity for a Frame
Entities can be used for efÞciently developing and managing a frame based site. The con-
tent of each frame can be an entity, so a framed page can be developed just with one doc-
ument for the frameset instead of requiring additional documents for each frame.

The entity is placed in a frame by using a URL for an entity as the source for the frame. 
For example, the following will embed a linked list of the documents of a site in a frame:

<FRAME SRC=”&url;?entity=documents”>

 Note the use of the entity reference &url;  in the link. It will expand to the URL of the 
current document. Of course, the URL of any location served by Interaction could be 
used in its place to resolve the entity as if it was placed in this document.

Summary
¥ An entity is a collection of content that can be referenced as a unit.

¥ The entity is embedded in a document using an entity-reference.

¥ An entity-reference consists of the name of the entity with an ampersand before and a 
semicolon after to separate it from the other content of the document, e.g. &time;

¥ The Entities dialog of the File menu provides an overview of available general enti-
ties.

¥ New entities can be created using the New button of the Entities dialog.

¥ Each entity is of a speciÞc type that determines its characteristics and how it is edited.
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¥ Additional entities and entity types come in the form of plug-in components.
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6. CHAT ROOMS
A Chat Room makes it possible to converse using a web browser. You can use a chat 
room to provide a meeting place for a group. Interaction Chat doesnÕt require partici-
pants to download special software or extensions to their web browser. Also, the Chat is 
designed to work with all recent browsers by not relying on frames or other non-stan-
dard features. The Chat Rooms of Interaction can be conÞgured in minutes, yet gives 
you extensive possibilities to create highly tailored chat rooms and more complex chat 
systems. This chapter will walk you through creating your own chat rooms.

How the Chat Works
A chat room provides a Þeld where participants can type in a statement. Clicking a sub-
mit button sends this statement to Interaction, which adds it to a list of previous state-
ments. Interaction then creates an HTML page that displays the list of statements as 
HTML, followed by a Þeld where a new statement can be typed. As several participants 
submit statements that are collected on a shared list, it become possible to have a dialog 
in close to real time.

Interaction chat is designed with the characteristics of the web in mind, rather than as an 
attempt to replicate similar chats in other media. It keeps track of when the various par-
ticipants last got an updated list of statements, so they donÕt have to read the same mes-
sages over and over. When a participant updates the room, Interaction will show all 
statements posted since their last update, plus one for continuity, with a minimum of 
four statements so the room never appears empty. By default, Interaction chat will dis-
play a maximum of 40 statements. These default minimum and maximum values can be 
changed using a Tool available from the Interaction site if you want to adapt the chat to 
special purposes.

Creating a New Chat Room
You can add an unlimited number of chat rooms and conÞgure these to best suit your 
purpose. 

1. Select the Chat Rooms dialog of 
the Services menu.

2. Click the ÒNewÓ button in the 
lower left corner of the Chat 
Rooms dialog.

3. Fill in a unique name for the Chat 
Room (this will be used as part of 
the URL).

4. Type a title and introduction for 
the room in the Þelds on the right 
in the dialog.

5. Close the dialog and save the changes to make the room available.
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Designing a Room
The chat rooms can be customized from a dialog, with no need to edit any Þles or 
markup.

Changing the Title and Introduction
The title and introduction of each room can be changed to reßect the purpose of the 
room:

1. Select the room you want to customize in the table on the left side of the Chat Rooms 
dialog

2. Fill in a title for the room in the Þeld labeled ÒtitleÓ. 

3. Add a description or introduction in the Þeld labeled ÒintroductionÓ.

4. Save the room to make the changes available. 

Modifying the Structure of Rooms
Each chat room can include a list of links to other rooms. In fact, even the ÒindexÓ is just 
another room that has a directory list but no Þelds for making statements. Each new 
room will automatically be appended to the directory listing of the ÒindexÓ room. 

To edit the directory list, select the room from the list in the left table of the Chat Rooms 
dialog, and click the ÒMoreÓ button to get a list of which rooms that are linked to from 
that particular room. 

Until you edit this list, all ÒdirectoryÓ entities will 
be empty except the one for ÒindexÓ.You can cre-
ate new items in the directory list for a chat room 
by using the ÒNewÓ button of the table to the 
right of the dialog. This will give you a pop-up list 

to select a room. You can also reorder the direc-
tory list by using the ÒupÓ and ÒdownÓ buttons.

This feature can be used to interconnect the 
rooms, and to make clusters of selected rooms. It 
gives you a high degree of freedom when it comes 
to organizing the rooms. For example, you can 
group rooms together under separate directory 
listings, put rooms in highly interconnected clus-
ters, make sequences where you advance from room to room, or other structures that Þt 
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the purpose of your site. Here are some possible ways to organize the rooms, where the 
lines between the rooms signify the links in its directory:

Advanced Customization
The chat service has many advanced features that allow you to adapt the rooms to Þt 
your needs and design. Using the advanced features of the chat service require that you 
are familiar with HTML and with entities and entity references (see the chapter "Entities" 
on page 25).

Adapting the HTML of a Room
You are not required to edit any HTML to set up chat rooms. However, if you are famil-
iar with markup, Interaction offers extensive abilities to customize the chat rooms to 
your design. Each room has an associated HTML Þle that deÞnes its appearance. This 
Þle can be used to deÞne your own highly tailored rooms. When you click the button 
labeled ÒEdit HTMLÓ, Interaction will give you access to the HTML in a text editor. Each 
room will have a default HTML formatting that you can adapt for your own purposes.

Using the Chat Entities
Various Òentity-referencesÓ embed the central features of a chat in the HTML (see the 
chapter "Entities" on page 25 for an introduction to entities and entity references). The 
following chat speciÞc entity-references can be used in the design of your rooms:

Entity Description

title  The title of the room as deÞned in the Þeld of the dialog.

introduction An introduction to the room as deÞned in the Þeld of the dialog.

nickname The nickname of the visitor.

statements A list of statements posted to the room.

refresh The automatic refresh rate of the room (require special markup to 
be activated)

directory An optional list of links to other chat rooms.

silence The time in seconds since the last statement was made.

List (default) Interconnected Separate Clusters

index index
index
Table 3: Entities of a Chat Room
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You can also embed the numerous entities listed in the Entities dialog of the File menu. 
Some of these general entities are very useful as part of the design of a chat room. For 
example, &occupancy;  will embed a counter for how many currently is in a room, 
while &visitors;  will embed a list of nicknames for the current participants in a con-
versation.

The Nickname Field
The INPUT Þeld with NAME="nickname" allow visitors to provide a name for them-
selves:

 <INPUT NAME=”nickname” SIZE=40>

This Þeld is part of the default chat rooms, but can alternatively be placed in pages with 
a submit button that leads to a chat room. This is useful when you would like to have an 
introductory page where the participant Þlls out personal information before they go to 
the chat. The nickname Þeld will be automatically eliminated if the participant has previ-
ously provided a nickname. Thus you may Þnd it useful to combine this Þeld with the 
entity-reference &nickname; so a previously chosen nickname will be in the place of the 
Þeld:

<INPUT NAME=”nickname” SIZE=40>&nickname;

Making a Default Nickname
You may want to provide a default nickname for your participants, such as their user-
name if they are registered. When a visitor submits a nickname Þeld Þeld to a chat room, 
Interaction will remember and use the nickname as long as the visitor is on your site, or 
until another nickname is submitted to supersede it. You can make this Þeld have as 
default value the username of a registered visitor by using the entity &username; for the 
initial value of the Þeld:

<INPUT NAME=”nickname” SIZE=40 VALUE=”&username;”>

Of course, any other entity or combination of entities can be used for the default value, 
such as the domain name of the participant.

If you want the username to be automatically used as nickname without allowing the 
participant to override it, make the Þeld above hidden:

<INPUT NAME=”nickname” TYPE=HIDDEN SIZE=40 VALUE=”&username;”>

This way, the Þeld will not be displayed in the chat room but will still submit a value for 

silence-sentence A sentence that describes how long it has been since last statement.

statement The content of the statement Þeld if the room is updated.

Entity Description

Table 3: Entities of a Chat Room
the nickname of the visitor.
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Persistent Nicknames
A nickname can be automatically reassigned when a participant in a conversation 
returns to your site. This is achieved by setting a cookie called ÒnicknameÓ containing 
the nickname of the visitor. The Chat service will look for a cookie called ÒnicknameÓ 
unless a nickname already is assigned. You can set the cookie with the nickname by add-
ing the following to the HEAD element of a chat room:

<META HTTP-EQUIV=”SET-COOKIE” VALUE=”nickname=&nickname;”>

This is a standard META tag as deÞned in HTML. For further documentation about this 
tag and what it does, see the HTML speciÞcation.

Avatars
An avatar is generally a visualization of a visitor in a Òvirtual spaceÓ. Avatars facilitate 
others in recognizing a participant, thus making the social experience more personal.

In Interaction Chat, any visitor can have an associated image which will be automati-
cally attached to the statements they make. You can use this feature to assign each visitor 
an image the Þrst time they get to the chat.

The value of any Þeld with NAME="image" that are submitted to a chat room will be 
kept by Interaction and used as the SRC for an image next time the participant makes a 
statement in any room. The Þeld does not have to be located in the chat room, but can be 
located in any form that submit to a chat room. 

This feature can also be used for facilitating issue-based discussions. You can make it 
possible for participants to change the image for each statement by adding a selector to 
the form in the HTML template of a chat room. An example would be to place the fol-
lowing tag inside the FORM element of a chat room:

     <INPUT NAME="image" SIZE=20>

The value typed in this form would be taken as the URL of an image to use with state-
ments posted by the visitor. Such Þelds can of course also be a set of radio buttons or 
other markup.

Private Statements
Participants in a conversation can post private statements to each other. These messages 
will not be seen by other participants, and can occur concurrently with a public chat. A 
message is made private when it is posted with a particular nickname as receiver.

Here is one possible way to add the markup to facilitate private messages in a chat room:

<SELECT NAME=”receiver”>
 <OPTION VALUE=””>Everybody</OPTION>
  &visitors;
</SELECT>

The entity for &visitor; will embed a dynamic created option list of visitor nicknames.
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The Statement Field
The content of the TEXTAREA with named ÒstatementÓ will be used for the statements 
that the participants want to make. Interaction will take care of emptying this entity-ref-
erence whenever a statement is sent. It is a good idea to use &statement; to set the 
default value of this to whatever value has been submitted previously, as this makes it 
possible for the participant to update the page and still keep partially typed statements.

Automatic Refresh
A chat room can be automatically reloaded with regular intervals (at least for visitors 
using Netscape-compatible browsers). This is achieved using a special Netscape HTML 
construct:

1. Go to the HTML template of a chat room using the Edit HTML button of the dialog of 
the room. 

2. Add the following tag within the <HEAD>...</HEAD> element of the template:

       <META HTTP-EQUIV="refresh" CONTENT="20">

This will cause the page to be reloaded every 20 seconds.

Optionally, you can make it possible for your visitors to change the refresh rate. The 
entity-reference &refresh;  provides refresh rates for the particular visitor for each 
room. The refresh entity default to the value 120 but can be changed by submitting a 
Þeld with name ÒrefreshÓ to the room. As an example, try to add the following meta tag 
in the HEAD element of the HTML of a room:

<META HTTP-EQUIV="refresh" CONTENT="&refresh;">

This will make the browser automatically refresh the room with the rate speciÞed by the 
refresh entity. Next, add an input Þeld in the FORM element of the chat room template, 
for example:

<INPUT NAME="refresh" VALUE="&refresh;">

This Þeld allow the participant in a conversation to change the refresh rate, and will at 
the same time show the current refresh rate. 

You can use a selector or other Þelds as you Þnd appropriate, just as long as its name is 
ÒrefreshÓ:

<SELECT NAME="refresh">
<OPTION SELECTED>&refresh;
<OPTION VALUE=”30”>30 seconds
<OPTION VALUE=”60”>60 seconds
</SELECT>

Hint:  Note the use of the &refresh; entity reference in the selected option element. This will make the pop 
up menu display the currently selected refresh frequency. You can also use this entity-reference in the con-
tent.

A last word about refresh: Although automatic reloading might sound like a good idea, 
it has its disadvantages. For example, it may confuse those that are not technically savvy, 
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making your service harder to use for beginners. Statements typed can get lost when a 
refresh occurs due to technical limitations of the browsers. Automatic refresh might 
invite the participants to be lurkers in the chat rooms rather than active participants. 
Also, your server will get more hits, reducing the number of possible participants in the 
chat. 

Accessories
The chat service has many optional features provided in the form of components and 
tools. You can download these from:

http://interaction.in-progress.com/components
http://interaction.in-progress.com/tools

The following is an introduction to some of the accessories for the chat service.

Transcribe Chat
The Transcribe Chat tool allows you to transcribe a chat conversation to Þle. This is use-
ful whenever you want to have a written record of a dialog. The conversation will be 
stored in HTML format, so you can immediately make it available on the web.

Filter Statements
The Chat Filter component substitutes phrases in the statements with other phrases. It 
can be used to eliminate unwanted language in a conversation. The Þlter can also be 
used to ensure that nobody is posting HTML or Javascript to a conversation. A more cre-
ative use of the chat Þlter is to substitute abbreviations in a conversation with its com-
plete value, for example, to convert ÒsmileysÓ in a conversation into images of smiling 
faces.

Purge Rooms
The Purge Rooms tool provides a dialog to erase all statements made in one or more 
rooms. This is useful to clear out the room before it is used again.
Remote Control
Remote control of the chat rooms are provided with entities such as Editor, Purger, and 
Eraser. The Editor entity embeds an editor in the room that can be used to change the 
title or introduction using a web browser, or add new rooms. The Purger entity makes it 
possible to purge the statements of a room from a browser. The Eraser allows the web-
master to remove a chat room from a browser. Either of these entities can only be used 
for those logged in as a member in the group ÒWebmasterÓ, and will be hidden for oth-
ers.

http://interaction.in-progress.com/components
http://interaction.in-progress.com/tools
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7.  FORUMS
A Forum is a place where people can discuss with others. The threaded discussion 
forums of Interaction are designed for elaborate discussions. Each message has its own 
page when presented on the web, so contributors have plenty of space to present their 
point of view. In contrast to services such as the Chat Room, where there are multiple 
messages on one page, participants will be able to make a complete argument even for 
complicated matters. The posted messages will be sorted on topics (threaded) to facili-
tate a more focused discussion and allow later participants to follow a discussion in an 
organized manner. 

The Forum service can be adapted to be used for a variety of other purposes beyond dis-
cussions. You can change the access restrictions   to create services such as private mail-
boxes or forums where only a few selected experts are allowed to answer. For more 
about access restrictions, see the chapter "Membership and Restrictions" on page 44.

Creating a New Forum
You create a new forum by using the Forums dialog available from the Services menu of 
Interaction:

1. Click the ÒNewÓ button to create 
a new forum. A dialog will 
request a unique name for the 
forum.

2.  Type in a name for the forum (or 
leave the default) and select OK. 
The new forum will appear as an 
item in the list of forums on the 
left side of the dialog. 

3. Fill in a title for the forum and a 
short introduction in the respec-
tive Þelds. 

4. Close the dialog, verifying that the new forum should be saved. Next time you visit 
the Forums, your new forum will be available as one of the options.

You can add an unlimited number of forums.

Designing a Forum
The title and introduction of each forum can be changed to reßect the purpose of the 
forum:

1. Select the forum you want to customize in the table on the left side of the Forums dia-
log

2. Fill in a title for the forum in the Þeld labeled ÒtitleÓ. 

3. Add a description or introduction in the Þeld labeled ÒintroductionÓ. 
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After saving the new deÞnition of the menu listing, you can access the changed page by 
pointing your web browser to the URL previously described.

Reordering the Directory of Forums
The index of forums has a directory of other forums that it links to. The table labeled 
ÒDirectoryÓ in the Forums dialog contains this list of forums when the index forum is 
selected:

1. Select the ÒindexÓ forum.

2. Click the More button to see all available options.

3. Use the ÒUpÓ and ÒDownÓ buttons to reorder the list of forums in the directory table.

Advanced Customization
The formatting of the various parts of a forum can be customized using HTML to Þt your 
needs and design. This require that you are familiar with HTML and with entities and 
entity references (see the chapter "Entities" on page 25). You can use the entities speciÞc 
to a forum location or any of the general entities as listed in the Entities dialog of the File 
menu.

Editing the HTML
The ÒMoreÓ button on the Forums 
dialog gives you additional options 
for customizing the forums. These 
options include declaring Moder-
ated forums, change the navigation 
icons of the forums, tailor the 
HTML templates for the various 
pages of a forum, and change the 
order of the links in the index of 
forums.

Customizing the Forums Index 
with Markup
You can customize the HTML of the forum index by selecting the ÒindexÓ in the Forums 
dialog and use the ÒEdit HTMLÓ button. A set of entity references are available to embed 
the central features of a forum menu:  

Entity Description

navigation A navigation bar for the forums.

title The title of the forum as deÞned in the Þeld of the dialog.

introduction An introduction to the forum as deÞned in the Þeld of the dialog.

directory A list of links to the forums.
Table 4: Entities of a forum menu
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Customizing a Forum with Markup
Each forum has associated HTML templates for its various pages. These templates give 
you extensive control of the HTML formatting of the pages. However, you are in no way 
required to edit these templates to use Interaction. 

The button labeled ÒEdit HTMLÓ gives you the default HTML template of a forum1. The 
template consists of HTML and content. In addition, there are a number of Òentity-refer-
encesÓ that dynamically embed central features of the forum (see ÒEntitiesÓ on page 25 
for more about this). The following entity-references can be used as part of your tem-
plate for a forum: 

The order for the topics of a forum can be controlled by submitting a Þeld with name 
Òtopics-orderÓ to the forum. If the value is ÒChronologicalÓ, the threads will be sorted in 
the order they were posted. If the value is ÒAlphabeticalÓ, the threads will be sorted 
depending on the alphabetical order of their subject, while ÒReverseÓ will list the threads 
in reverse chronological order. The following form can be placed in a forum to allow the 
visitor to control the order of the topics:

<FORM>
<SELECT NAME=”topics-order”>
<OPTION>Chronological
<OPTION>Alphabetical
<OPTION>Reverse
</SELECT>
<INPUT TYPE=SUBMIT VALUE=”sort”>
</FORM>

The entity reference &topics-order;  can be used to provide feedback about the cur-
rent order.

The overview of threads can also include the messages in each thread. An argument with 
name ÒformatÓ and value ÒthreadsÓ will cause the topics to be embedded with all mes-
sages included. This can be achieved by placing the following in the HTML of a forum:

<FORM>
<INPUT TYPE=HIDDEN NAME=”format” VALUE=”threads”>

Entity Description

title The title of the forum as deÞned in the Þeld of the dialog.

introduction An introduction to the forum as deÞned in the Þeld of the dialog.

topics A list of topic threads of messages posted to the forum.

topics-order The order of the topics.

Table 5: Entities of a forum
1.If you ever want to revert to the default, just remove all text in the HTML Þle before closing it.
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<INPUT TYPE=SUBMIT VALUE=”Show Messages”>
</FORM>

The list of threads can be limited to only show threads that have been posted to within 
the last days. Submitting an argument ÒoutdatedÓ with a numerical value will cause the 
topics only to list threads posted to within the given number of days. For example, the 
following HTML form will allow the visitor to control how old messages are displayed:

Only show threads posted to the last <FORM><INPUT NAME=”outdated”></FORM> 
days.

Editing the Post and Reply Forms
Each forum has associated documents for posting new messages and replying to a mes-
sage in a thread. The Post and Reply links on the Forums dialog has a shortcut to these 
documents, and selecting either gives you a dialog where you can edit the documents 
and templates to match the purpose of your own Forums.

Changing the Formatting of Threads
The threads in a forum are associated with an HTML Þle to control the formatting of the 
HTML pages. This Þle is available from the Forums editor by following the links named 
ÒThread HTMLÓ. In addition to all the general entities of Interaction, the following enti-
ties can be used to customize the formatting of threads: 

Entity Description

navigation The navigation bar

title An automatically generated title

subject The subject of the thread (only for replies).

in-reply-to The key for the message which this is a reply to (only for replies).

thread The key for the current thread (only for replies).

Entity Description

navigation The navigation bar of the forum.
title A synonym for the subject of a thread

subject The subject of the thread.

messages A list of the messages in a thread

next Link to the next thread, if any.
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Changing the Formatting of Messages
The messages in a forum have an HTML Þle that control how they are formatted. This 
template is available from the Forums editor by following the links named ÒMessage 
HTMLÓ. 

Moderated Forums
A forum is declared moderated by checking the ÒModeratedÓ checkbox. Messages 
posted to a moderated forum will not be publicly available before they are reviewed by a 
moderator. 

Messages posted to a moderated forum will get an access restriction (see page 44) that 
makes the message inaccessible and not listed. This access restriction must be manually 
changed from the Locations dialog to make the documents available. A specialized Tool 
that facilitates moderation will be made available. 

Changing the Navigation Icons
Interaction is pre-conÞgured with icons located on a central site making it easy for you to 
get the forums working. Clicking on the Navigation hyperlink on the Forums dialog 
gives you the dialog to change these icons. You might Þnd it appropriate to download 
the original icons to your own site or make your own. However, note that Interaction 
does not serve images, thus the icons cannot be added to the Documents folder.

Hint:   In the bottom of the Navigation dialog are Þelds for the optional width and height of the icons. You 
may Þnd it useful to Þll in these values, as it will speed up the display of the forum pages on browsers that 
support width/height (e.g. Netscape). The values for the default icons is 32 for both width and height.

Removing Messages and Threads
Messages and threads can be removed from the Locations dialog of the File menu. Select 
the thread or message and use the Remove button to delete. All messages in a thread will 
be erased with the thread. The Þrst message in a thread cannot be removed before all the 
replies has been removed.

Entity Description

navigation The navigation bar

title A title for the message

subject The subject of the message, usually same as the thread

post-time A timestamp for when the message was posted

author The name of the author of the message

email A link with the email address of the author of the message

in-reply-to A link to the message which this is a reply to, if any

message The content of the message

signature The signature of the message
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8. MEMBERSHIP AND RESTRICTIONS
The Membership feature is used to give individuals access privileges so you can make 
speciÞc locations accessible only for selected people and groups. Access Restrictions con-
trol accessibility of a location as well as when it will be linked from other pages. Together 
these provide a ßexible scheme for adapting the presentation depending on visitor and 
context. Interaction allows an unlimited number of members and will look up the user-
name and password just as fast no matter how many members you have.

Members
Members are visitors that have their own 
username and password for your site1. 

Adding a New Member
The list of members is edited using the 
members dialog of the Windows menu:

1.  Click the ÒNewÓ button. This will cre-
ate a new item in the list of members. 

2. Type in a username and password in 
the corresponding Þelds.

Assigning a Member to a Group
A member can optionally be in one or more groups. All groups have a corresponding 
access restriction which makes a document accessible only for those who are in the 
group. The table to the bottom right of the Members dialog depicts the groups that a par-
ticular member belongs to. To assign a member to a group:

1. Click the ÒJoinÓ button. This will bring a dialog that ask you to type the name of a 
group.

2. Type a name for a new group, or the name of a previously created group.

3. Click the OK button. This will add a group to the list that shows the group member-
ship of the member.

DeÞning a Webmaster
A webmaster has special access privileges to your site. Typically modiÞcations are by 
default restricted to webmasters. A webmaster is anyone in the group WEBMASTER. 
Here is how to add yourself as webmaster:

1.  Click the ÒNewÓ button. This will create a new item in the list of members. 

2. Type in a username and password for yourself in the corresponding Þelds.

3. Click the ÒJoinÓ button. This will bring a dialog which asks you to type the name of a 
group. Type WEBMASTER as the name for the group. Click the OK button to com-
plete. 

1. The concept ÒMembersÓ as used in Interaction is similar to what often is referred to as ÒUsersÓ, 
but ÒMembersÓ is more suited in this context as a web site usually is public available without 

requiring any passwords.
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Access Restrictions
Each location has an access restriction, which determine who and in which context the 
location can be accessed. This can be used to adapt the site to each visitor as well as to 
keep parts of the site inaccessible for those without the right privilege.

Restricting Access
Access restrictions can be changed using the ÒAccessÓ pop-up menu of the Locations 
dialog. For example, you can set a document only to be accessible for members at your 
site. You can then assign username and password to individuals using the membership 
dialog on the Windows menu. The location will not be accessible unless the visitor has a 
username and password which veriÞes membership.

Adaptive Indexes Based on Secrecy
Interaction has the ability to hide speciÞc locations depending on their access privilege. 
This feature is used to get the site adapted to each visitor. The ÒSecretÓ pop-up menu of 
the Locations dialog is used to deÞne when a location is to be considered secret. Interac-
tion will not include a secret location in any automatically generated content (e.g. index 
listings created by the forum or chat service, or by the ÒdocumentsÓ entity).
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9. EXTENDING INTERACTION
Interaction can be extended without programming or scripting, by adding new compo-
nents, tools, and cgi applications. The technical reference are found in a separate manual, 
and introduced in the next chapter.

Components
Interaction is extensively component-based, where the application acts as a con-
tainer for dynamic objects that extend Interaction with new features or modiÞes 
the functionality. Components have unlimited ability to change the Interaction 
application, providing a far more powerful scheme than traditional CGIÕs or 
APIÕs. New components can be downloaded from:

http://interaction.in-progress.com/components

Components will be integrated in the application upon invocation.  To install a compo-
nent, add the Þle or Þles to the Components folder and restart Interaction to activate. In 
some cases you can activate a component by double-clicking its icon or dropping it on 
the application icon.
New Tools
In a similar way as you can extend Interaction by adding Þles to the plug-ins folder, you 
can add special components to a folder called ÒToolsÓ and get these executed from the 
menu of Interaction. If a ÒToolsÓ folder exists in the same folder as the Interaction appli-
cation, its content will be listed in a ÒToolsÓ menu. When you choose any of these items, 
Interaction will open or execute the Þle.

CGI Applications
Interaction can be extended with external applications (often called CGIs). This is done 
by adding the CGI application to the documents folder, and then restarting Interaction to 
make it available. The application must be running in advance of the request, and the Þle 
is required to have the extension Ò.cgiÓ or Ò.acgiÓ (however, this extension will be 
ignored in the URL).

http://interaction.in-progress.com/components
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10. TROUBLESHOOTING
The Þrst place to go in case of problems is to the Interaction FAQ:

http://interaction.in-progress.com/faq

The Problem Report
The ÒProblem ReportÓ Þle in the Log folder provide a log of problems that have been 
taken care of by Interaction. In case of problems, the last items in this report might pro-
vide hints for a solution.

Common Problems
This section provides solutions to potential problems when using Interaction.

Garbage Characters in the Response
If the server is incorrectly conÞgured it may attempt to serve the Interaction application 
Þle. This will appear as a long, cryptic mix of sentences and data.

¥ If Interaction is acting as a CGI (i.e. you use Ò/interaction$Ó as part of the URL): 
There might be an item in the sufÞx map of the server causing it to consider any Þle 
without sufÞx to be a document to download. This has shown to be the case with the 
default setting of some versions of Web Server 4D. The Þx is to either remove the suf-
Þxless item from the map, or setting its action to be Interaction.

¥ If the server is conÞgured with Interaction as a preprocessor:
The problem can probably be eliminated by creating a new location called ÒInterac-
tionÓ, optionally containing a link to the Ò/indexÓ location. 

¥ If the server is conÞgured with Interaction in its sufÞx map: 
The problem is probably due to an incorrect sufÞx map for Interaction and/or an alias 
to the Interaction application located in the same folder as the server. The Þx is to 
remove the alias and make sure that the sufÞx map is correct (see page 9 for more 
about how to conÞgure the server).

Slow Speed
Interaction does not work very well with Virtual Memory, RamDoubler or SpeedDou-
bler. Either will typically slow down Interaction to half the speed or less. The Þx is to use 
real memory and disable these applications. If you cannot avoid using them, make sure 
that Interaction is the Þrst program that is started when restarting the computer.

Document Contains No Data
Does the browser show an empty page or displays a ÒDocument Contains No DataÓ dia-
log? 

The reason might be that Interaction does not provide a location for this particular URL. 
An empty page is the way Interaction tells the browser to take care of the request. Some 
browsers have bugs that causes it to not continue processing, but instead return the 
empty page. You may consider to report this as a bug to the server developers.

http://interaction.in-progress.com/faq
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If there is a location that corresponds to the request, Interaction might have had an 
immediate problem in creating a response. The Problem Report may contain a message 
that indicates what went wrong. If there is such a message and it does not make sense, 
consider to report it as a bug given that it happens regularly.

Unexpected Quits
Interaction should be very stable and rarely if ever crash. However, Interaction is some-
what sensitive to low memory, and might fail if this is the case. The ÒAbout InteractionÓ 
dialog will show how much free memory Interaction has available. If this number is 
below 500K it is a good idea to increase the allocated memory. Please report it If you 
encounter any events of Interaction crashing while still having a lot of memory allo-
cated.

Broken Graphics
You might have encountered problems with graphics that do not show up when you 
browse the pages and Interaction is running as a CGI.   Unless Interaction is set up with 
mime mapping (see page 9) or preprocessor, images cannot be referred using a relative 
URL (e.g. "images/img.gif"). The problem can be eliminated by using a full URL (e.g. 
Òhttp://www.yourserver.com/images/img.gifÓ) or an relative URL that contains an 
absolute path (e.g. Ò/images/img.gifÓ).

Unresolved Entity-References
Syntax errors in the markup might cause Interaction to ignore embedding the value of 
entity-references. Interaction attempts to write an understandable error message in the 
Problem report when encountering such situations. The most common syntax error is to 
forget a closing quote in an tag attribute value, e.g.: 

<A HREF="http://www.ifi.uio.no/~terjen> 

This will cause Interaction to consider the text that follows the URL to be part of the 
attribute. Another common error is to leave a less-than sign '<' in your document with-
out it being part of a tag.

Search Argument Conßict With Other Software
To be able to reliably track visitors, Interaction will add a unique ID for a visitor to the 
search arguments of all URLs, such as Ò....?id=123456Ó. Unfortunately, a few non-mac 
web servers report an error whenever encountering a request with such search argu-
ments, typically reporting that the server doesnÕt accept any search args in that URL. 
Also, links to some external CGIÕs may fail due to unexpected search arguments.

The solution is to make sure that Interaction doesnÕt add a visitor ID in the rare instances 
where other software has problems with the visitor ID. This can be accomplished using 
the SGML markup for a Òmarked sectionÓ to describe that the link is to be kept 

unchanged by Interaction. For example, to deÞne a link to be kept as it is, make it into a 
CDATA marked section by putting Ò<![ CDATA [Ò before the link and Ò]]>Ó after: 

<![ CDATA [<A HREF=”http://www.in-progress.com/”>In Progress</A>]]>
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Interaction will then format the link without any id number or other changes. The 
markup for the marked section will not be passed on to the browser.

Loosing Track of the Visitor
Interaction might fail to track the visitor in some circumstances. This might occur in 
cases where there are syntax errors in the markup as described in the section "Unre-
solved Entity-References" on page 48. Simpler servers such as MacHTTP might also 
loose track of visitors during automatic refresh.

Reporting a Bug
No software is free from bugs, and real use as opposed to artiÞcial testing will usually 
reveal bugs unforeseen by the developers. It is important that you report any bugs so 
these can be repaired for the future. If possible, you may get back a Þx for the bug within 
days of reporting it, so you can beneÞt from it being repaired without having to wait 
until the release of the next version of Interaction.

Bugs can be reported by sending an email to:

bugs@in-progress.com

Using this address ensures that your bug report gets to my immediate attention. The 
more information given related to the problem, the better. It is appreciated if you provide 
as many as possible of the following in a bug report:

1. A description of the problem, what you do to make it happen, and what actually hap-
pens. This will facilitate replication of the problem, which is key to identifying what 

is wrong. 

2. The version code of Interaction. You can get this from the ÒAbout InteractionÓ dialog 
on the Apple menu. The version code will typically look like Ò1.0Ó and can be 
reported as ÒI am using Interaction 1.0Ó.

3. The last items in the ÒProblem ReportÓ just after the problem has occurred. You can 
view the problem report by selecting this item on the Windows menu. If you have 
any problems with accessing this, you may alternatively enclose the complete Þle 
called ÒErrorsÓ in the Log folder of Interaction.

4. Other information that you believe might be useful, such as what other software you 
have running on your computer.
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11. TECHNICAL DOCUMENTATION
Interaction can be inÞnitely modiÞed and extended with scripting or programming. It 
has a built-in ANSI-standard dynamic object-oriented scripting/programming lan-
guage, and is in itself an object database of scripts, programming parts, and data which 
can be dynamically adapted as you wish. There are several reasons to make use of these 
capabilities: 

¥ You want to script smaller features to your site or make script to help you maintain 
your server.

¥ You want to create extensive modiÞcations and adaptions of Interaction and its ser-
vices to best suit your purposes.

¥  You are a third party developer interested in providing extensions for the growing 
number of Interaction users.

The technical details about how to extend and modify Interaction with scripts and pro-
grams will be incrementally documented. Updated technical reference material for Inter-
action is found at:

http://interaction.in-progress.com/documentation

Interaction provides an exciting and powerful framework for creating advanced web 
services:

¥ Intergrated ANSI-standard object-oriented scripting/programming language  with 
more than 2000 well-tested functions. Any of your code can be reused in other context 
and platforms.

¥ Your extensions have direct access to all internal functionality of Interaction, and can 
even modify it.

¥ Code can be embedded directly in the markup in the form of processing instructions to 
allow for quick prototyping of new features. 

¥ Dynamic evaluation allows the application to be extended and modiÞed at run-time, 
with no need for compilation.

¥ Support for compilation and execution of AppleScript and other OSA scripting lan-
gauges

¥ ModiÞcations and extensions can be distributed as plug-in components in either com-
piled or even uncompiled as interpreted code.

¥ Tools to facilitate authoring and site maintainance can be distributed just as the plug-
ins, but will be added to the Tools folder and Þrst executed when the corresponding 
item is selected from the Tools menu.

¥ Implements the CGI standard familiar from the UNIX platform for extending your site 
with scripts in InteractionÕs internal scripting language. In addition, Interaction sup-
ports the AppleEvent based CGI-alike protocol for scripts written in AppleScript or 
other environments that can receive AppleEvents.

¥  Dynamic locations can be deÞned in the form of a ÒpatternÓ using object-oriented pro-

gramming, providing a sophisticated way to add new features to your site. No need to 

http://interaction.in-progress.com/documentation
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mess with limited APIÕs when you instead can use self-containing dynamic objects for 
integrating extensions.

¥ Built-in object database and TCP/IP support.

¥ New code libraries can be added as plug-ins.

¥ New features can be deÞned as subclasses of existing ones. The internal structure and 
superclasses of Interaction will be incrementally documented to facilitate your efforts 
in deÞning new access restrictions, entity types, document types, services, tools, and 
other extensions.
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